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Introduction  
 

This document presents a sample experiment that makes use of the Plexon® CinePlex® 

tracking and marker capabilities to aid in the evaluation of hippocampus place cell 

activity. The goal of this experiment is to track an animal’s movement in a maze, and 

then compare the animal’s location in the maze (as a function of time) with the activity of 

the place cells in the animal’s hippocampus. The Plexon OmniPlex® System is used to 

record the necessary neural data.  

CinePlex Applications to Use 

In this experiment, we will track the x,y position of the animal in the experimental arena 

using the CinePlex Studio recording and tracking functions, while simultaneously 

recording neural activity of the place cells with the OmniPlex System. Then we will use 

the CinePlex Editor application to insert markers into the video stream to highlight the 

times during which substantial place cell activity is exhibited in the neural data. 

The timing for the integrated OmniPlex/CinePlex System is controlled by a single clock, 

so the neural recording and the video stream are time-locked (synchronized) throughout 

the experiment.  

This experiment requires the CinePlex Tracking license (CPT-V3) along with an 

OmniPlex license. 

Integrated System  

The configurations presented in this document are: 

 Applicable to a CinePlex System integrated with an Plexon OmniPlex® D Neural 
Data Acquisition System 

 Based on Version 3.7 of CinePlex Studio and Version 3.6 of CinePlex Editor 

software 

It is assumed that the CinePlex and OmniPlex Systems, including the PC and software, 

have been factory prepared and tested by Plexon prior to shipment. 

Technical Support 

Plexon technical support is available by telephone at (+1) 214-369-4957 or by email at 

support@plexon.com. Please contact us if you would like additional information or 

assistance with your experiments. 

mailto:support@plexon.com
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Additional Resources 

For detailed feature descriptions, licensing options, hardware requirements, start-up 

procedures and advanced configuration options, see the CinePlex and OmniPlex user 

guides on the Plexon website, www.plexon.com. 

 (Optional) Tracking the Head Direction 

If you want to see where the animal’s attention was during the experiment, consider 

attaching an LED headstage or purchasing LED equipped headstages with the Plexon 

system. The CinePlex System can record LED positions for each video frame. See the 

CinePlex System User Guide for detailed procedures. 

 

Startup and Operational Testing 

 
Follow the general system startup procedure in the CinePlex System and OmniPlex 

System user guides to connect cables, prepare the cameras, and get data flowing in the 

CinePlex and OmniPlex Systems. 

Camera(s) 

CAUTION: Never plug or unplug a camera FireWire cable with the PC power ON. 

Permanent damage to the camera could result. 

One or more camera(s) were supplied with the original shipment of the CinePlex 

System. One camera is sufficient for this experiment (a two-dimensional maze) if it has 

a clear view of the entire experimental arena. It should typically be mounted above and 

orthogonal to the arena. In general, it is best to position the camera as far from the 

experiment as possible, then zoom as much as possible in order to fill the field of view 

with the area of interest without distortion. 

 
Use the physical settings on the camera lens to obtain the best possible image. Do this 

before configuring any camera settings in the CinePlex software.  

http://www.plexon.com/


 

CinePlex Technical Note – Place Cells in Hippocampus Plexon Doc. No. CPXTN0003a, June 2017 Page 4 

Note: The settings that are available on a particular lens depend on the lens make and 

model. Not all settings are available on all models. 

More than one camera can be used if it is necessary to ensure you always have a clear 

view of the animal, but in this example we use one camera mounted directly above the 

center of the arena. 

It is very important to mount the camera securely. Any movement of the camera could 

invalidate the spatial calibration and tracking data.  

Lighting of the Experimental Arena 

Lighting for this experiment is very important, because the video images must be clear 

enough for the tracking algorithm to function efficiently. Lighting should be sufficient to 

view animal activity that is expected to occur during the experiment. Keep in mind that 

some cameras can react to lighting variations or flashes of light. Therefore, some 

preliminary video recordings should be done to ensure that tracking data is being 

faithfully recorded under all expected lighting conditions. If the experiment is to be 

performed in very dim lighting, consider using an infrared camera and illumination. 

 

Physical Constraints 

For experiments in which an animal will be moving through a large maze, consider other 

physical constraints in your experiments, such as a need for a longer headstage cable 

or clips to hold a headstage securely to the animal. 

 

Tips for Better Tracking and Data Management 
 

AVI File – It is strongly recommended that you select the Audio Video Interleaved (AVI) 

checkbox to record the original video with embedded data. This file can be very useful 

later if you want to retrack the video with revised settings. 

DVT File – You should also select the digital video tracking (DVT) checkbox, which 

configures the system to create a DVT file during the recording session. This file 

contains all the positional data (x,y coordinates) in a format that can easily be opened in 

a text application, spreadsheet, or many external programs. (See the image, below.) 
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Background subtraction – If you are using Object Contour (whole body) tracking, it 

may be useful to subtract the arena background. Selecting the Use Background 

checkbox configures the system to subtract the background image from the video, and 

typically improves tracking accuracy. However, you might find it sufficient to select Dark 

on Light or Light on Dark in the Object vs. Background row. 

 

 

 

PLX buttons – You must select at least one PLX button to cause the CinePlex System 

to send coordinate data to the OmniPlex System. The diagrams below show examples 

of PLX buttons for different tracking modes – Object Contour, LEDs and Color Markers.  
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Note: When a PLX button is selected, it turns orange; when it is not selected, it is clear. 

 

   

 

Recording Procedure 
 

Set up the camera, start the system and calibrate the arena by means of the procedures 

described in the CinePlex Studio User Guide. Then record the neural and video data 

together as described in the user guide. 

Note: When CinePlex Studio is in the Armed state (      ), the cassette icon in the status 

bar is yellow (       ). When recording starts, the icon turns green (       ).  

During the recording process, verify that the system is successfully tracking the animal’s 

location in the arena. 
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If you want to save all the settings in this Studio file, select Save Settings from the File 

dropdown menu or click the save icon in the toolbar ( ). The system will prompt you 

to enter a new name for this settings file, although you can enter the same (original) 

name of the file if you want to overwrite it. 

 

Viewing Neural and Video Files Simultaneously 
 

To view the neural and video files together, use CinePlex Editor. Follow the procedures 

described in the CinePlex Editor User Guide. The highlights are presented below. 

1. Double-click the CinePlex Editor icon ( ). Wait for the CinePlex Editor 

application main window to appear on the monitor. 

2. On the Welcome screen, start a new Editor project by clicking on the Start button. 
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3. Browse to select the AVI file and the neural data file that were recorded during a 

specific experiment. In the example below, the files are from the folder 

“CinePlexv35Files.” The “_1” at the end of the AVI file name indicate that the 

original video was taken with Camera 1. Use an appropriate name for the project 

(cpj) file. Then click the Continue>> button. 

 
 

4. In the Verify Project Files dialog box, verify that the information is correct. Then 

click the Continue>> button. 
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CinePlex Editor creates the CPJ file and opens the CinePlex Editor main view. 

 

 

 

                                                     Slider 

 

5. View the animal’s activity frame by frame by moving the slider left and right. The 

video images and neural activity indicators are time-locked (synchronized), 

because both recordings were created under the control of a single clock.  
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Adding a Marker to Identify Important Points in the Data 

 
In this example, you will want to add markers to the video stream to identify time 

intervals during which there is substantial place cell neural activity. You do this by  

[1] defining a marker to bracket the intervals of place cell activity, then [2] entering 

marker occurrences whenever place cell activity is seen in the neural data stream. 

Defining the Marker “Place Cell” 

1. Click Play ( ) to start the video and neural data, then click Pause ( ).  

(Although pausing is not required, the video can be distracting when you are 

performing other operations in CinePlex Editor.)  

 

2. Define a new marker to denote the time intervals of place cell activity. This can 

be done in three ways: 

a. Click the New Marker button ,  

b. or, from the Edit menu, click Define New Marker, 

c. or, from the right-click menu in the Markers window, select Define New 

Marker. 

The Define New Marker dialog box appears. 

 

 



 

CinePlex Technical Note – Place Cells in Hippocampus Plexon Doc. No. CPXTN0003a, June 2017 Page 11 

Note: The F (Frame) marker is a special time-only marker applied automatically 

by CinePlex Studio to associate a time with each video frame. This marker 

always appears grayed out in the Define New Marker dialog box because it is 

system-generated. 

3. In the Type area, click “I” to define an interval marker.  

 

4. In the Name box, in the place of the default name Interval type “Place Cell.” 

Retain the default settings for the other items.  

 

 
 

 

Notice in the example above that the Associated Keystroke (which will be used 

for Marker Occurrences) is “G” and the display Color is beige. You can change 

these values if desired.  

 

5. Click OK.  
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The Place Cell entry appears in the Markers window. However, there are no 

occurrences of this marker, so the value in the Count column is 0. 

 

 

 

Adding Marker Occurrences To Intervals with Place Cell Activity 

Initially, we rough in all the marker occurrences during one continuous pass through the 

video, then we go back and adjust each marker occurrence to be as accurate as 

possible. Then this information is saved to a NEX file, from which we can easily load it 

into the NeuroExplorer® application for analysis. 

Denoting place cell activity in the video (roughing in marker occurrences) 

1. Click Play ( ). Adjust the Faster and Slower settings ( ) to a 

comfortable speed to view the video, which balances the desire to get through 

the video quickly against the risk of missing enhanced place cell activity should it 

occur too quickly to spot. 
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2. Use the Zoom In and Zoom Out buttons at the bottom of the Activity window to 

adjust the time range such that, should the place cell activity be spotted in the 

neural data, a key on the keyboard can be hit before the time of the first place 

cell activity scrolls out of the Activity window. 

 

 
 

3. In the Input window, at Keystroke, click Insert. (You could just as easily 

use the Button or Left-click input method here.) CinePlex Editor is now armed to 

enter new occurrences of the new marker when you press that marker's 

associated key. 

 

Notice that “Place Cell” is displayed as one of the available Markers. 
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4. Click Rewind. Click Play. Position a finger over the associated keystroke as you 

watch for the “Place Cell” event. 

 

 
 

5. Watch the video closely as it plays. When you see the place cell activity starting 

in the neural data, quickly press the associated key (“G” in this example).  

 

When you see the place cell activity stopping in the neural data, press the key 

(“G”) again to complete the interval. These two keystrokes (starting and stopping) 

define this particular marker occurrence as a “Place Cell” interval. The interval 

appears in the Activity window. 

 

You can press the key as many times as necessary during the playing of the 

video to identify all the place cell activity intervals. Accuracy is not important at 

this point; fine-tuning will come later. Go through the entire video.  

 

 

 

 

Key 

Intervals displayed in  
Activity window 

Video stream 
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Making fine adjustments to marker occurrences 

6. Now we will go back through and adjust the time of the “Place Cell” marker 

occurrences to be more accurate. We will use the Find function to quickly locate 

our marker occurrences. In the Input window, after Keystroke, click Find. 

 

7. Rewind the video file, then press the assigned key for the “Place Cell” marker. 

This causes the system to jump to the start of the first marker occurrence in the 

Activity Window. Notice that the complete interval for each occurrence is 

displayed (start to finish). Use the left and right arrow keys on the keyboard to 

look at the neural data to decide where the place cell activity actually occurs.  

 

8. In the Activity window, drag the marker occurrences to the correct time. To do so, 

press and hold the Shift key, then click near the tick mark for the marker 

occurrence. Drag the tick mark to the desired time and release the mouse button. 

You can move the Start and Stop tick marks for each interval in this manner. 

 



 

CinePlex Technical Note – Place Cells in Hippocampus Plexon Doc. No. CPXTN0003a, June 2017 Page 16 

9. Review the recorded tracking data and see if any of the recorded x,y coordinates 

suddenly went to (0,0) for one or more frames. This can happen, for example, if 

an LED light was occluded by a cable or object in the arena. If you see several 

such (0,0) coordinates in the data, consider correcting them manually in your file 

with a simple arithmetic interpolation. If there are many such (0,0) coordinates, 

you should modify the values of the Tracking parameters in the user interface 

then retrack the AVI file. Refer to “Retrack AVI Procedure” in the CinePlex Studio 

User Guide for the necessary procedure. 

 

10. If you want to save all the settings in this Editor project file, select Save Project 

As… from the File dropdown menu or click the save icon in the toolbar ( ). The 

system will prompt you to enter a new name for this settings file, although you 

can enter the same (original) name of the file if you want to overwrite it. 

 

 

Data Analysis 
 

Now that you have marked the time intervals during which place cell neural activity 

occurred, you can look back through the video, focusing on those intervals of 

interest, and see what the animal was doing during those specific intervals. 

The DVT file that the system created during the experiment contains time-stamped 

x,y coordinates that you can use in further analyses. The coordinate system has its 

origin at the lower left corner of the video frame, as shown in this diagram. 
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Be aware that the DVT coordinates (and the coordinates in the PLX and PL2 files) are 

always expressed in the 0-1023 format, not in pixels. There is an algebraic relationship 

between the DVT coordinate system and real pixels. See “Extractor Procedures” in the 

CinePlex Studio User Guide for further information about DVT coordinates and pixels 

in uncalibrated arenas. 

Note: Remember that the coordinates will be extracted from the AVI file in pixels if 

the Use Calibration checkbox was not checked during recording. See the examples 

below.  

 

 

Saving the Data 

To save the data: On the File menu, click Export to NEX, and if desired, select the 

appropriate What to Export checkboxes. Click Export! to write the file. 

Note: Exporting markers is supported for PLX files but not PL2 files. 

Perform additional analyses and data management procedures in the NeuroExplorer 

application. 
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